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Como Usar Presionar-para-Examen

Las guias para muchas evaluaciones internacionales, nacionales y
estatales permiten o requieren que los estudiantes usen dispositivos
portatiles TI-Nspire™ cuando resuelven un examen.

Presionar-para- Examen le permite preparar con rapidez los dispositivos
portatiles de los estudiantes para los examenes en los que el uso de
aplicaciones, programas u otros archivos esta restringido. Cuando un
dispositivo portatil esta en el modo de Presionar-para-Examen, los
estudiantes no pueden tener acceso a carpetas, documentos y datos del
Bloc de Notas preexistentes. Los estudiantes que utilizan los dispositivos
portatiles TI-Nspire™ CX-C no pueden acceder al diccionario chino-inglés.

Presionar-para-Examen deshabilita en forma temporal los documentos y
ciertas caracteristicas de las aplicaciones de un dispositivo portatil.
Después del examen, estos documentos y caracteristicas se pueden
restaurar con facilidad para usarlos en el salén de clases.

La funcién Presionar-para-Examen esta disponible en los siguientes
dispositivos portatiles TI-Nspire™:

* Los dispositivos portatiles TI-Nspire™ y TI-Nspire™ CAS con la versidon
del sistema operativo 1.3 o superior

e Los dispositivos portatiles TI-Nspire™ CX y TINspire™ CX CAS con la
version del sistema operativo 3.0 o superior

e Los dispositivos portatiles TI-Nspire™ CX-Cy TI-Nspire™ CX-C CAS
con la versién del sistema operativo 3.1 o superior

e Los dispositivos portatiles TI-Nspire™ CM-C y TI-Nspire™ CM-C CAS
con la versidn del sistema operativo 3.1 o superior

Presionar-para-Examen también esta disponible en el TI-84 y cuando se
usa un dispositivo portatil TI-Nspire™ en el modo TI-84.

Nota: Algunos estados solo permiten el uso de TI-Nspire™ en modo
TI-84. Para averiguar si su estado permite la tecnologia de TI-Nspire™,
consulte el sitio web de Informacién Estatal/Provincial en:

education.ti.com/educationportal/sites/US/nonProductSingle/
stateoverview.html

Como Habilitar el Modo Presionar-para-Examen
1. Asegurese de que el dispositivo portatil esté apagado.

2. Enun Touchpad, mantenga presionadas las teclas (GFen].
En un Clickpad: Mantenga presionadas las teclas @ G
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No suelte las teclas hasta que se despliegue la pantalla de Presionar-
para-Examen.

Prewvent access to pre—existing Scratchpad
data, documents and folders.

Angle Settings:

Select additional restrictions:

[/] Limit geametry functions

D|Sable function and conic grab and
mawve E

[7] Enter Press-to-Test Canc

De manera predeterminada, se seleccionan todas las restricciones.
Debe cambiar las configuraciones para las restricciones antes de
ingresar al modo Presionar-para-Examen. No puede cambiar las
configuraciones después de ingresar al modo Presionar-para-
Examen, a menos que salga y lo habilite de nuevo.

Seleccione las restricciones adicionales o limpie las restricciones

segun sea necesario.

e  Para aceptar las configuraciones predeterminadas, presione
o haga clic en Ingresar a modoPresionar-para-Examen.

e Para limpiar todas las configuraciones predeterminadas,
presione [ctri][9]. Use la barra de desplazamiento para ver las

restricciones y haga clic en el cuadro de comprobacién
correspondiente para seleccionar una de estas.

e En un Clickpad: Presione o haga clic en Ingresar a modo
Presionar-para-Examen.

Cuando usted ingresa al modo Presionar-para-Examen:

e Los datos preexistentes del Bloc de Notas se borran
temporalmente.

e Losdocumentosy las carpetas preexistentes dentro de la carpeta
Mis Documentos se borran temporalmente.

Nota: Los datos del Bloc de Notas, los documentos y las carpetas
preexistentes se recuperan cuando se quita el modo Presionar-
para-Examen.

e Se crea una carpeta “Presionar-para-Examen” dentro de la
carpeta Mis Documentos.
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e Siesta instalado, se deshabilita el diccionario chino-inglés en los
dispositivos portatiles TI-Nspire™ CX-C.

Como Cambiar las Configuraciones Predeterminadas

1.

Para limpiar todas las configuraciones predeterminadas, presione

(] (9).

Si desea cambiar las configuraciones de 4ngulo, presione para
resaltar el menu.

a) Presione w para desplegar la lista de opciones. Las opciones
disponibles son: grado, radian y gradian.

b) Presione a o w para resaltar la opcidon que desea elegir.
¢) Presione para seleccionar la opcion.
En un Clickpad: Presione G para seleccionar la opcién.

Presione o presione w para moverse por la lista de restricciones.
Para tener acceso rapido al ultimo elemento de la lista, presione a.

Continue presionando a para moverse hacia arriba por la lista de
restricciones.

Cuando haya una restriccion resaltada, presione para limpiar la
opcién. Cuando se limpia la opcién, esta queda disponible para los
estudiantes. De manera predeterminada, todas las restricciones estan
seleccionadas (no disponibles para los estudiantes). Puede
seleccionar o limpiar las siguientes funciones:

e Limitar funciones de geometria
¢ Deshabilitar la funcion para agarrar y mover las cénicas

e Deshabilitar las funciones de vector, incluidos los vectores
propios y los valores propios

¢ Deshabilitar la funcion “isPrime"” (es primo)

¢ Deshabilitar graficador de ecuaciones diferenciales
e Deshabilitar graficador de desigualdad

¢ Deshabilitar el graficador en 3D

¢ Deshabilitar el graficador implicito, las plantillas de cénicas, el
analisis de conicas y las conicas geométricas

e Limitar funciones trigonométricas

e Deshabilitar la plantilla logpx y las funciones de sumatoria
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e Deshabilitar Buscador de Raiz Polinomial y Solucionador de
Ecuaciones Simultaneas

5. Presione para seleccionar Ingresar a Modo Presionar-para-
Examen y después presione [enter].

En un Clickpad: Presione para seleccionar Ingresar a modo
Presionar-para-Examen y después presione ().

El dispositivo portatil guarda las configuraciones y se reinicia. Cuando el
reinicio se haya completado, se desplegara el siguiente cuadro de
didlogo para confirmar que el dispositivo portatil esta en el modo
Presionar-para-Examen.

Nota: La pantalla de su dispositivo portatil puede ser diferente,
dependiendo de que usted modifique o no las configuraciones
predeterminadas del modo Presionar-para-Examen. Usted no puede
cambiar las configuraciones después de que el dispositivo portatil se
reinicia.

Haga clicaqui para

Press—to-Test transferir el modo

This handheld is in Press—to-Test mode. Presionar-para-
Restrictions include: Examen a otro

Angle Settings: Degree diSPQSi_tiVO
portatil.

and folders are disabled.

Pre-existing Scratchpad data, documents =
Limit geometry functions H

Hagaclicen? Disable function and conic grab and
para acceder e ™

ala ayuda. (7] Transfer Press—to-Test

Haga clic en OK
para aceptar las
configuraciones.

6. Presione (%] o para seleccionar OK.
En un Clickpad: Presione 0 Ga para seleccionar OK.

Se abrird la pantalla de Inicio.
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El icono de
Candado
indica que el
dispositivo
portatil esta
en el modo
Presionar-
para-Examen.

BN

Como tener acceso a la Ayuda

1. Desde la ventana Presionar-para-Examen, haga clicen ¥, que se
encuentra en la esquina inferior izquierda.

Desde un documento abierto, presione y luego seleccione el
modoPresionar-para-Examen > Ayuda.

En un Clickpad: Presione (o) (6 y luego seleccione Presionar-
para-Examen > Ayuda.

La ventana de Ayuda se abre, permitiéndole ver informaciéon acerca
de cada restriccion.

.

2 Help

I How to set-up your handheld:|

If wou are using a Touchpad keypad, to put
wour handheld in Press—to-Test mode, turn
wour handheld OFF, then hold down ESC and
ON at the same time.

It wou are using a Clickpad keypad. to put vour

handhald in Pracc—tn-Tact mada fum smnr

o

2. Haga clic en OK para cerrar la ventana de Ayuda.

=]

Como Salir de Configuracion

Para salir de la pantalla de Presionar-para-Examen sin habilitar el modo
Presionar-para-Examen:

1. Presione o presione para seleccionar OK.
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2. Presione [enter],
En un Clickpad: Presione Gasp.

Como Operar el Dispositivo Portatil en el Modo
Presionar-para-Examen

Cuando un dispositivo portatil estéd en el modo Presionar-para-Examen, el

indicador de luz LED de la parte superior del dispositivo portatil

parpadea, de modo que pueda ver con rapidez que Presionar-para-

Examen esta encendido —incluso cuando el dispositivo portatil esté

apagado.

e Sielindicador de luz LED parpadea en verde-verde, todas las
restricciones estan seleccionadas.

e Sielindicador de luz LED parpadea en amarillo-amarillo, una o mas
restricciones se han limpiado.

Nota: Los dispositivos portatiles TI-Nspire™ CAS mas antiguos no tienen
un indicador de luz LED en la parte superior. El LED de los dispositivos
portatiles TI-Nspire™ CM-C indica solamente el estado de la bateria y no
parpadea cuando se habilita Presionar-para-Examen.

Como Verificar las Restricciones del Modo Presionar-para-
Examen

Para verificar las restricciones seleccionadas:
1. Apague el dispositivo portatil.
2. Presione para encender el dispositivo portatil.

En un Clickpad: Presione (& para encender el dispositivo portétil.

Se abre un cuadro de didlogo que muestra las restricciones de
Presionar-para-Examen seleccionadas.

1 Press—to-Test

This handheld is in Press—to-Test mode.
Restrictions include:
Angle Settings: Degree

and folders are disabled.

Limit geometry functions

Pre-existing Scratchpad data, documents ﬂ

Disable function and conic grab and

[7] Transfer Press—to-Test
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3. Presione (%] o para seleccionar OK.
En un Clickpad: Presione 0 Gy para seleccionar OK.

Se abrird la pantalla de Inicio.

Configuraciones del Sistema

Cuando se inicia Presionar-para-Examen, las configuraciones del sistema
para el dispositivo portatil se configuran de manera predeterminada. Las
configuraciones del sistema en el dispositivo portatil antes de iniciar
Presionar-para-Examen no se retienen. Usted puede cambiar las
configuraciones del sistema mientras esté en el modo Presionar-para-
Examen. Cuando usted sale del modo Presionar-para-Examen, todas las
configuraciones del sistema se restauran a las configuraciones
seleccionadas antes de haber entrado al modo Presionar-para-Examen.

Como Eliminar Documentos de la Memoria

Si usted tiene muchos documentos almacenados en el dispositivo portatil,
quiza no tenga suficiente memoria para iniciar Presionar-para-Examen. Si
no hay suficiente memoria, se despliega el mensaje “No hay suficiente
memoria para entrar al modo Presionar-para-Examen. Por favor, elimine
algunos documentos primero.” en el dispositivo portatil.

Para restaurar la memoria, debe eliminar algunos de los documentos
antes de poder entrar al modo Presionar-para-Examen. Para resolver este
problema:

e Borre los documentos innecesarios de su dispositivo portatil.

e Use el software TI-Nspire™ para respaldar documentos en una
computadora o en otro dispositivo portatil. Usted puede restaurar
los documentos después de que salga del modo Presionar-para-
Examen.

Como Apagar o Encender el Dispositivo Portatil en el Modo
Presionar-para-Examen

Si usted apaga el dispositivo portatil o si entra en el modo de
desconexion automatica Automatic Power Down™ (APD™) mientras se
encuentra el modo Presionar-para-Examen, permanecera en el modo de
prueba cuando se encienda de nuevo. Un mensaje le recordara que el
dispositivo portatil estd en el modo Presionar-para-Examen y le mostrara
las restricciones seleccionadas.
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This handheld is in Press—to-Test mode.
Restrictions include:
Angle Settings: Degree
Pre-existing Scratchpad data, documents =
and folders are disabled.

Limit geometry functions

Disable function and conic grab and

[7] Transfer Press—to-Test

Nota: Si hay un cuadro de didlogo abierto cuando el dispositivo portatil
se apaga mientras se encuentra en el modo Presionar-para-Examen,
dicho cuadro de didlogo aparecera cuando encienda nuevamente el
dispositivo portatil.

Como Limpiar y Volver a Ingresar al Modo Presionar-para-
Examen

Cuando un dispositivo portatil esta en el modo Presionar-para-Examen,
usted puede limpiar los datos agregados en una sesiéon anterior sin salir
del modo Presionar-para-Examen. Los datos incluyen archivos, datos del
Bloc de Notas y librerias. Para limpiar los datos de una sesién anterior:

1. Asegurese de que el dispositivo portatil esté apagado.
En un Touchpad: Presione (@ton].
En un Clickpad: Presione (o) (.

2. Presione para encender el dispositivo portatil.

En un Clickpad: Presione @ G

Se desplegara la pantalla de Presionar-para-Examen.
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Haga clicen
v Restablecer
This handheld is in Press—to—-Test mode. Presionar-para-

Restrictions include: Ex_arpen para
Angle Settings: Degree eliminar los datos.

Pre-existing Scratchpad data, documents =
and folders are disabled.

Limit geometry functions

Disable function and conic grab and

Reset Press-to-Test

3. Haga clic en Restablecer Presionar-para-Examen para eliminar los
datos.

Para retener los datos de la sesién anterior, haga clic en OK.

Al seleccionar Restablecer Presionar-para-Examen se retienen todas
las restricciones y se eliminan todos los documentos creados y los
datos ingresados en la sesion anterior de Presionar-para-Examen.

Nota: Si usted ingresé y guardé datos en el dispositivo portatil en el
modo TI-84, esos datos no se eliminaran si el dispositivo portatil se limpia
en el modo Presionar-para-Examen por medio de un teclado numérico de
TI-Nspire™. Sin embargo, en el TI-84 Plus no es posible acceder a los
datos cuando se usa el teclado numérico de TI-Nspire™.

Autoguardado

Si el dispositivo portatil se reinicia mientras se encuentra en el modo
Presionar-para-Examen, el dispositivo portatil permanece en el modo de
prueba y regresa al ultimo documento abierto.

Como administrar la energia de la bateria

Si usa un dispositivo portatil TI-Nspire™ o CAS de TI-Nspire™, usted
puede retirar y reemplazar las baterias mientras se encuentre en el modo
Presionar-para-Examen. Si usted cambia las baterias, el dispositivo
portatil permanecera en el modo de prueba. Cuando lo encienda de
nuevo, se desplegara el cuadro de didlogo de recordatorio.

En cualquier dispositivo portatil que utilice bateria recargable, antes de
iniciar el modo Presionar-para-Examen o antes de comenzar un examen
debe asegurarse de que la bateria recargable esté completamente
cargada.
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Cémo Cambiar de Teclado Numérico

Todos los dispositivos portatiles TI-Nspire™ CX tienen teclados numéricos
fijos. No puede cambiar a un teclado numérico diferente si utiliza los
dispositivos portatiles TI-Nspire™ CX, TI-Nspire™ CX-C o TI-Nspire™
CM-C.

Cuando use un dispositivo portatil TI-Nspire™ o TI-Nspire™ CAS,
asegurese de salir del modo Presionar-para-Examen antes de intentar
cambiar a un teclado numérico distinto; por ejemplo, de un teclado
numérico TI-Nspire™ a un teclado numérico TI-84 Plus y viceversa.

Si usted cambia de teclado numérico mientras se encuentra en el modo
Presionar-para-Examen, el dispositivo portatil desplegara el siguiente
mensaje:

Unsaved Document {6 bl ]
MName o) Size
O Unsaved Document
LF:'! Creco—Tn—1 act Mk

This key pad is not compatible with the current
Press to Test mode. Please revert to the key
pad used when entering Press to Test mode.

Como Trabajar con Documentos en el Modo
Presionar-para-Examen

Cuando el dispositivo portatil se encuentre en el modo Presionar-para-
Examen, todas las carpetas y los documentos presentes en el dispositivo
portatil antes de haber entrado en el modo Presionar-para-Examen
estaradn deshabilitados. Mientras esté en el modo Presionar-para-Examen,
usted solo vera la carpeta de Presionar-para-Examen en Mis Documentos.

Los profesores pueden enviar y recopilar documentos cuando los
dispositivos portatiles se encuentren en el modo Presionar-para-Examen.
Sin embargo, si usted desea recopilar un documento que los estudiantes
hayan creado o editado mientras se encontraban en el modo Presionar-
para-Examen, debera recopilar los documentos desde los dispositivos
portatiles de los estudiantes antes de salir del modo Presionar-para-
Examen.

Como Tener Acceso a Mis documentos

1. Presione para acceder a la pantalla de Inicio.
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En un Clickpad: Presione (@b).

2. Seleccione Mis Documentos para abrir el administrador de archivos.

&S iy Documents
[/ Press—to-Test 0K

Usted puede crear, guardar o borrar carpetas y documentos dentro de la
carpeta de Presionar-para-Examen.

Abrir un Documento Nuevo

1. Presione para acceder a la pantalla de Inicio.
En un Clickpad: Presione (6.

2. Seleccione Documento Nuevo o [t | [N] para abrir un documento
nuevo.

3. Use v y .a pararesaltar la aplicacion que desea agregar a la
pagina y luego presione [enter],
En un Clickpad: Presione Gw.
Si aparece un icono de candado ﬂ junto al nombre del documento

abierto en la barra de titulo, significa que el dispositivo portatil se
encuentra en el modo Presionar-para-Examen.

6T Ty

=
=
.
»
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Como Transferir Presionar-para-Examen a los
Dispositivos Portatiles

Use la funcion Transferir Presionar-para-Examen para instalar con rapidez
una configuracién de Presionar-para-Examen en los dispositivos
portatiles de los estudiantes sin usar una computadora. Un profesor o
supervisor puede:

Configurar un dispositivo portatil “transmisor” con las restricciones
requeridas para un examen y habilitar Presionar-para-Examen.

Conectar el dispositivo portatil “transmisor” a un dispositivo portatil
“receptor”. Ambos dispositivos portatiles deben estar encendidos.

Conecte los dos
dispositivos
portatiles por
medio de un cable
USB mini a mini.

5 QB3 |DET

T
AAER

Envie la configuracion de Presionar-para-Examen al dispositivo
portatil conectado. El dispositivo portatil conectado se reinicia, y se
habilita Presionar-para-Examen.

Requisitos
Tenga en cuenta los siguientes requisitos cuando envie una configuracién
de Presionar-para-Examen de un dispositivo portatil a otro.

Si envia una configuracién de Presionar-para-Examen a un
dispositivo portatil que ya estd en modo Presionar-para-Examen, se
sobrescribiran las restricciones de Presionar-para-Examen en el
dispositivo portatil receptor y se perderan todos los datos capturados
durante la sesion de Presionar-para-Examen.

12
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El dispositivo portatil transmisor debe tener la misma versién de
sistema operativo que el dispositivo portatil TI-Nspire™ receptor, o
bien una versién superior.

Si el dispositivo portatil receptor no tiene memoria suficiente, la
transferencia de la configuracion de Presionar-para-Examen fallara.

Como Enviar una Configuracion de Presionar-para-Examen
a un Dispositivo Portatil

Para enviar una configuracién de Presionar-para-Examen de un
dispositivo portatil a otro, siga los pasos a continuacion.

1.
2.

Habilite Presionar-para-Examen en un dispositivo portatil transmisor.

Conecte el dispositivo portatil transmisor a un dispositivo portatil
receptor por medio de un cable USB mini a mini.

Asegurese de que tanto el dispositivo portatil transmisor como el
dispositivo portatil receptor estén encendidos.

En el dispositivo portatil transmisor, se abre un cuadro de didlogo
que muestra las restricciones de Presionar-para-Examen
seleccionadas.

This handheld is in Press—to-Test mode.
Restrictions include:
Angle Settings: Degree
Pre-existing Scratchpad data, documents
and folders are disabled.

Limit geometry functions

Disable function and conic grab and

[7] Transfer Press—to-Test

Haga clic en Transferir Presionar-para-Examen.

La configuracién de Presionar-para-Examen se envia al dispositivo
portatil receptor. Cuando se completa la transferencia y se reinicia el
dispositivo portatil conectado, se muestra un mensaje de
confirmacion.
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_‘ Press—-to-Test

This handheld is in Press-to-Test mode.

Transfer Press—to-Test

Transfer completed. You can unplug and
connect to another handheld.

5. Desconecte el dispositivo portatil receptor, conéctelo a otro
dispositivo portatil y repita el paso 4 hasta que todos los dispositivos
portatiles estén configurados.

Como Salir del Modo Presionar-para-Examen

Al salir de Presionar-para-Examen se limpian todos los datos y archivos
creados mientras se encuentra en el modo Presionar-para-Examen. Todos
los archivos y las configuraciones del sistema se restauran a su estado
original antes de que se habilitara Presionar-para-Examen en el
dispositivo portatil

e Se borran todos los documentos creados durante la sesién de
Presionar-para-Examen. Si vuelve a ingresar al modo Presionar-para-
Examen, la carpeta de Presionar-para-Examen estara vacia.

e Sise abrié un documento antes de entrar al modo Presionar-para-
Examen, ese documento se restaura en la misma vista (Mis
documentos, Ordenador de paginas o vista de pagina) cuando usted
sale del modo Presionar-para-Examen. Si el documento contenia
cambios no guardados, el documento abierto restaurado
permanecera sin guardar.

¢ Sino hay ningun documento abierto, el dispositivo portatil despliega
Mis documentos.

Como Salir de Presionar-para-Examen en un Dispositivo
Portatil

Si un dispositivo portatil tiene Presionar-para-Examen habilitado, puede
conectarlo a cualquier otro dispositivo portatil TI-Nspire™ que no tenga
Presionar-para-Examen instalado para eliminarlo del dispositivo portatil
habilitado.
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Nota: Los dispositivos portatiles pueden mezclarse. Puede conectar un
dispositivo portatil TI-Nspire™ CX a un dispositivo portatil TI-Nspire™, o
conectar un dispositivo portatil TI-Nspire™ CAS a un dispositivo portatil
que no tenga CAS.

1.

Conecte el dispositivo portatil que tiene Presionar-para-Examen
habilitado a otro dispositivo portatil TI-Nspire™ mediante el cable de
conexion de unidad a unidad.

Asegurese de que ambos dispositivos portatiles estén encendidos.

En el dispositivo portatil que tiene Presionar-para-Examen
habilitado, seleccione Mis Documentos y presione para
acceder al menu Documentos.

En un Clickpad: Presione (o, seleccione Mis Documentos y presione

Seleccione Presionar-para-Examen. Esta opcion de menu estd activa
Unicamente mientras se encuentra en el modo Presionar-para-
Examen.

Presione p y seleccione Salir de Presionar-para-Examen.

Documents
1: File

2 Edit

3 W ey

4 Insert

5 Page Layout

& Refresh Libraries

7 Setfings & Status p

2 Login...
9 Press—to—Te|

1 )
2 Transfer Press—to-Test
3 Help

e Siel dispositivo portatil esta conectado a otro dispositivo
portatil, el dispositivo portatil sale del modo Presionar-para-
Examen y se reinicia en el modo normal. Si ambos dispositivos
portatiles estan en el modo Presionar-para-Examen, ambos
dispositivos portatiles salen de Presionar-para-Examen.

¢ Sino hay ningun dispositivo portatil conectado correctamente,
aparece el siguiente mensaje:
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Exit Press—to-Test

Connect your TI-Mspire Handheld to another
TI-Mspire Handheld and try again.

=
e El dispositivo portatil no sale del modo Presionar-para-Examen
hasta que se reinicia. Si usted desconecta el cable durante la
transferencia, su dispositivo portatil permanecera en el modo
Presionar-para-Examen.

Nota: También puede salir del modo Presionar-para-Examen al recibir
correctamente una actualizacion del sistema operativo (desde un
dispositivo portatil o el software de computadora). Recibir el mismo SO
no causara que el dispositivo portatil salga del modo Presionar-para-
Examen.

Como eliminar el modo Presionar-para-Examen de
varios dispositivos portatiles

Los profesores que usen el TI-Nspire™ Navigator™ Teacher Software
pueden utilizar la Herramienta de Transferencia para deshabilitar
Presionar-para-Examen de varios dispositivos portatiles conectados a la
computadora. Los dispositivos portatiles deben estar encendidos y
conectados a través de uno de estos medios:

e La TI-Nspire™ Docking Station o la TI-Nspire™ CX Docking Station
e Soporte TI-Nspire™ Navigator™

e Adaptador de red inalambrico TI-Nspire™ CX

e Una conexién directa por medio de un cable USB estandar

Como Eliminar el modo Presionar-para-Examen mediante
la Herramienta de Transferencia

1. Cree un archivo .tns vacio con el nombre “Salir del Modo de
Prueba.tns” y gudrdelo en la carpeta TI-Nspire™ predeterminada.

Nota: El nombre de archivo es sensible al uso de mayusculas y
minusculas; por lo tanto, debe nombrarlo tal como se indicé.
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En el Espacio de Trabajo de Contenido, seleccione Herramientas >
Herramienta de Transferencia.

Se abrira la Herramienta de transferencia.
Haga clic en Agregar a la Lista de Transferencia.

Navegue a la carpeta donde esté ubicado el archivo “Salir del Modo
de Examen.tns"” y selecciénelo para agregarlo a la lista de
transferencia.

En la Herramienta de Transferencia, seleccione el archivo Salir del
Modo de Examen.tns.

El campo Editar Carpeta de Destino se activara cuando seleccione el
nombre del archivo.

* Transfer Tool

Setup | Status |

| Add to Transfer List || Remove Selected | [] Delete all files and folders before transfer

File Mame Destination Folder Size

[FZlExit Test Mode ins [E=W Transfers-11-9-11

Edit Destination Folder: [Press-to-Test M| Change

|- Start Transfer | |- Close |

Escriba Presionar-para-Examen en el campo Editar Carpeta de
Destino y haga clic en Cambiar.

No puede navegar a la carpeta Presionar-para-Examen en el
dispositivo portatil.

Haga clic en Iniciar transferencia.

El archivo “Salir del Modo de Examen.tns” se envia a los dispositivos
portatiles conectados, y el modo Presionar-para-Examen se

deshabilita. Los dispositivos portatiles se reinician y se carga el
sistema operativo.
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Para eliminar el modo Presionar-para-Examen de los dispositivos
portatiles adicionales, desconecte los dispositivos portatiles
reiniciados y conecte los otros dispositivos portatiles. El proceso de
transferencia continuara hasta que usted lo detenga.

Para detener la transferencia, haga clic en Detener Transferencia.

Haga clic en Cerrar cuando se hayan completado todas las
transferencias.

Como Eliminar el modo Presionar-para-Examen en una
Clase

Cuando una clase esta en sesion, puede eliminar el modo Presionar-para-
Examen enviando el archivo “Salir del Modo de Prueba.tns” a la clase.
Cuando envie el archivo, todos los estudiantes que iniciaron sesién
recibiran el archivo. Los estudiantes que no hayan iniciado sesion
recibiran el archivo cuando lo hagan. Para eliminar el modo Presionar-
para-Examen:

1. Haga clic en Herramientas > Enviar a Clase.
Se abrira el cuadro de didlogo Seleccionar archivo(s) para enviar.
2. Asegurese de que la pestafa Archivos esté abierta.
3. Navegue a la carpeta donde se encuentra el archivo “Salir del Modo
de Examen.tns” y selecciénelo.
4. Haga clic en Siguiente.
Se abrira el cuadro de didlogo Seleccionar individuo(s).
Step 2 of 2 - Selectindividual(s) x
a8
Class
Individuals
Send to handheld folder: IF'reSsHu—Tes( -
[“] Loggedin only
< Back | Finish \ ‘ Cancel
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5. Haga clic en Clase ““* para enviar el archivo a toda la clase. Para
enviar el archivo sélo a los miembros de la clase que han iniciado
sesion actualmente, seleccione el cuadro de comprobaciéon Sélo
sesion iniciada.

Nota: Para enviar el archivo a un estudiante en particular, haga clic

en Individuos (% y luego haga clic en el nombre del estudiante.

6. Escriba presionar-para-Examen en el campo Enviar a Carpeta de
Dispositivo Portatil.

7. Haga clic en Terminar.

Para los estudiantes que iniciaron sesion, el archivo “Salir del Modo
de Prueba.tns” se envia a los dispositivos portatiles conectados y se
deshabilita el modo Presionar-para-Probar. Los dispositivos portatiles
se reinician y se carga el sistema operativo.

Entendiendo las Restricciones del modo
Presionar-para-Examen

De modo predeterminado, todas las restricciones se seleccionan cuando
ingresa el modo Presionar-para-Examen y se deshabilitan las opciones
respectivas en los menus de la aplicacién. Cuando se selecciona una
restriccion, se deshabilita la funcién asociada.

Como Restringir las Funciones de Geometria

Cuando usted elija limitar las funciones de geometria, todas las opciones
en los menus de Medicién, Construcciéon y Transformacion estaran
deshabilitadas.

Nota: Presione v y .a para desplazarse por los elementos del menu de
la aplicacion.
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Las opciones en

% 6; Measurement
A7 Construction
.= & Transformation

{71 90 Settings. ..

Views estos menus estan
- 1cm| deshabilitadas en
i\, 3: Trace ’ el modo Presionar-
= 4 Points & Lines | para-Examen.
(15 Shapes »
»
»
4

Como Restringir las Funciones de Graficos

En el menu Graficos, las siguientes opciones se encuentran
deshabilitadas:

Acciones:
& [1: Actiong & FEEETNES

[ 2: View 2 Select p|| > Coordenadasy
# 3: Graph | ® 3: Hide/Show Ecuaciones

17 4 Windoy 5= 4 Attributes

7 5 Trace | 5: Set Conditions

\4 6 Analy=z{€ 6: Delete all

“0 7 Table |Abl 7: Text

&4 8 Geomd’® 8 Coordinates and Equations
{1l 9: Setting a+_b 9: Calculate

11 A Redefine

¥ B: Insert Slider

f1{x)=| —
X 1: Actions Geometria:
31 2: View > Medicién
A 3: Graph Entry/Edit » > Construccion
1% 4: Window / Zoom  p
A% 5: Trace » > Transformacion

\d'6: Analyze Graph »
/: Table U 1: Points & Lines b
«" 8: Geometry M=) 2: Shapes 4

1L 2b e % 3. Measurement  »

4 Construction P
fT(XH .-* 5: Transformation b
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Como Deshabilitar Agarrar y Mover las Funciones y las
Cdnicas

No puede mover ninguna funcién ni cénica en Gréaficos, Geometria o

Bloc de Notas. Por ejemplo, si grafica y=x>, puede seleccionar la
funcién, pero no puede moverla de ninguna manera.

Deshabilitar Agarrar y Mover las Funciones y las Cénicas no se aplica
a las lineas y funciones de Datos y Estadisticas.

Deshabilitar Agarrar y Mover las Funciones no restringe los
deslizadores en las aplicaciones de Graficos y Geometria.

Aunque si se puede agarrar el plano cartesiano y moverlo alrededor.

Como Deshabilitar las Funciones de Vector

Cuando se deshabilitan las funciones de vector, los estudiantes no seran
capaces de calcular las siguientes funciones:

Vector de unidad [unitV(]
Producto cruz [crossP(]
Producto punto [dotP(]
Vector propio [eigVc(]
Valor propio [eigVI(]

El vector se deshabilita en las siguientes ubicaciones.

Ubicacion/Aplicacion Ruta de acceso

Catalogo

o TE3 : Deshabilitar [unitV(], [dotP(],
[eigVc(] y [eigVI(]

o 2 : Deshabilitar Vector > Vector

Unitario, Producto Vectorial y Producto

Punto

z ]z : Deshabilitar Matriz > Valores

Propios > Avanzados y Matriz > Vectores

Propios > Avanzados
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Ubicacion/Aplicacion Ruta de acceso

Calculadoray Blocde | > Matriz y Vector > Vector> Vector
Notas Unitario

. > Matriz y Vector > Vector>
Producto Vectorial

. > Matriz y Vector > Vector>
Producto Punto

. > Matriz y Vector > Valores Propios>
Avanzados

. > Matriz y Vector > Vectores
Propios> Avanzados

Notas . > Calculos > Matriz y Vector> Vector
> Vector Unitario

. > Calculos > Matriz y Vector >
Vector > Producto Vectorial

. > Calculos > Matriz y Vector >
Vector > Producto Punto

. > Calculos > Matriz y Vector >
Valores Propios > Avanzados

. > Calculos > Matriz y Vector >
Vectores Propios > Avanzados

Como Deshabilitar la Funcion “isPrime” (es primo)

La funcién isPrime( se usa para determinar si un niimero es un nimero
primo (un nimero entero mayor de dos que solo es divisible por unoy
por si mismo). Deshabilitar esta funcién evita que los estudiantes
seleccionen el comando isPrime( en el Catdlogo y que seleccionen
Probar > IsPrime en |los Operadores Matematicos. Cuando un estudiante
introduce manualmente la funcién isPrime(, al enviar la expresion se
produce un mensaje de error.
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Coémo Deshabilitar el Graficador de Ecuaciones
Diferenciales

El tipo de grafico de Ecuacion Diferencial se deshabilita en las
aplicaciones de Gréaficos y Geometria. Los usuarios no pueden escribir ni
graficar manualmente una ecuacion diferencial. Las opciones para
graficar ecuaciones diferenciales estan deshabilitadas en los siguientes
menus.

Ubicacion/Aplicacion Ruta de acceso
Gréaficos y Bloc de . > Ingresar/Editar Grafico > Ec. Dif.
Notas

o (o] > Ingresar/Editar Grafico >

Ecuacion Diferencial

Geometria (dentrode | > Ingresar/Editar Grafico > Ec. Dif.

una ventana Analitica)
o (o] > Ingresar/Editar Grafico >
Ecuacion Diferencial

Como Deshabilitar el Graficador de Desigualdad
Cuando se deshabilita el graficador de desigualdad, los estudiantes no

pueden graficar desigualdades con <, >, £y 2 ni agarrar y arrastrar
desigualdades a un grafico en las aplicaciones de Gréficos y Geometria y
Bloc de Notas.

Como Deshabilitar el Graficador en 3D

Cuando se deshabilitan las opciones para usar el graficador en 3D, estas
aparecen deshabilitadas en los siguientes menus.

Ubicacion/Aplicacion Ruta de acceso
Gréaficos y Bloc de > Vista > Graficador en 3D
Notas
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Como Deshabilitar el Graficador Implicito, las Plantillas de
Conicas, el Analisis de Cénicas y las Conicas Geométricas

Cuando se deshabilitan estas opciones, los estudiantes no pueden
graficar ecuaciones del tipo x = ay + ¢ 0 ax + by = c. Las plantillas de
conicas no estan disponibles, y los estudiantes no pueden analizar cénicas
ni graficar la conica geométrica de una elipse, parabola, hipérbola o
conica de cinco puntos.

Ubicacion/Aplicacion Ruta de acceso
Gréaficos y Bloc de > Ingresar/Editar Grafico > Ecuacion
Notas
Graficos y Bloc de > Analizar Gréfico > Analizar Cénicas
Notas
Gréaficos y Bloc de > Geometria > Figuras
Notas

Se deshabilitan la elipse, parabola, hipérbola
y cénica de cinco puntos.

Geometria > Figuras

Se deshabilitan la elipse, parabola, hipérbola
y cOnica de cinco puntos.

Como Deshabilitar Funciones Trigonométricas
Deshabilitar las funciones trigonométricas evita que los estudiantes usen
las funciones deshabilitadas en los calculos o el graficador.

e Siusted presiona en el dispositivo portatil, las funciones csc, sec,
cot, csc-1, sec-1y cot-1 estaran deshabilitadas.

* Los estudiantes no pueden seleccionar comandos y asistentes
deshabilitados desde el Catalogo (al presionar en el dispositivo
portatil).

e Los estudiantes no pueden seleccionar Operadores Matematicos y
asistentes deshabilitados.

e Cuando un estudiante intenta introducir manualmente funciones
deshabilitadas en una expresion, al enviar la expresion se produce un
mensaje de error.

Las funciones trigonométricas limitadas se incluyen en la siguiente tabla:

csc sec cot

1 -1

csC sec cot™
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arccsc arcsec arccot

arccsch arcsech arccoth

sech sech™! csch

csch™( coth coth™(

Como Deshabilitar la Plantilla logpx

Se evita que los estudiantes usen los comandos y las plantillas logyx
(convertir a logbase) y log(a, b), incluidas las plantillas logpx.

e Cuando los estudiantes presionan Jlog, en el dispositivo portatil, sélo
se aceptan los calculos en el formato log10.

e Cuando un estudiante introduce manualmente los comandos
log(a,b) y >logbase(,, al enviar el comando se produce un mensaje
de error.

e Los estudiantes tienen permitido introducir log(a), log(a,10) y
log(a,10).
Como Deshabilitar las Funciones y Plantillas de Sumatoria

o
Se evita que los estudiantes usen los comandos, °*" |, y las plantillas

relacionadas con la sumatoria. Se deshabilitan los comandos Y (y

1a

o
sumSeq(. En especifico, "= | se deshabilita en las siguientes ubicaciones:
Ubicacion/Aplicacion Ruta de acceso
Teclado numérico g
Notas . > Calculos > Célculo > Suma

Clickpad: () > &

Calculadoray Blocde | > Célculo > Suma
Notas
Clickpad: () > &
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Ubicacion/Aplicacion Ruta de acceso

Catal e
atalogo (=) o TE3 : Deshabilitar Z( y sumSeq(

z ]z : Deshabilitar X(

4oy - Deshabilitar | (CAS: 5o

Deshabilitar |I3||)
o 5 u : Deshabilitar ;‘ (CAS: & il

Deshabilitar E‘)

Como deshabilitar el Buscador de Raiz Polinomial

Se deshabilitan los comandos polyRoots(, cPolyRoots(, solve(,
cSolve(, simult(, cSimult(, zeros(, y cZeros(. Cuando los estudiantes
intentan introducir manualmente estos comandos, al enviar el comando
se produce un mensaje de error.

En especifico, estos comandos estan deshabilitados en las siguientes
ubicaciones.

Nota: Cuando las herramientas polinomiales estan deshabilitadas, el
usuario no puede usar Encontrar Raices de Polinomio, Raices Reales de
Polinomio ni Raices Complejas de Polinomio.

Ubicacion/ Ruta de acceso
Aplicacion
Notas . > Calculos > Algebra > Solucion
Numérica

. > Célculos > Algebra > Resolver Sistema
de Ecuaciones Lineales

. > Calculos > Algebra > Herramientas
Polinémicas

Calculadoray Bloc . > Algebra > Solucién Numérica

de Notas ) ]
. > Algebra > Resolver Sistema de
Ecuaciones Lineales

. > Algebra > Herramientas Polindmicas
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Ubicacion/

Ruta de acceso

Aplicacion
Catalogo ine
go (=) o VI : Deshabilitar polyEval(, polyRoots(,
cPolyRoots(, solve(, cSolve, zeros(, y cZeros
o ZIE : Deshabilitar:

1. Algebra > Herramientas Polinémicas
—  Encontrar raices de Polinomio
— Raices reales de Polinomio
— Raices complejas de Polinomio
2. Algebra > Resolver
3. Algebra > Ceros
4. Algebra > Complejo Resolver
5. Algebra > Complejo Ceros

Nota: Algunos de los elementos enumerados
son especificos para el dispositivo portatil
TI-Nspire™ o el dispositivo portatil TI-Nspire™
CX CAS.

Cémo Deshabilitar el Solucionador de Ecuaciones

Simultaneas

Se deshabilitan los comandos linSolve(, simult(, y cSimult( en los menus
y en el Catalogo. Cuando los estudiantes intentan introducir
manualmente estos comandos, al enviar los comandos se produce un

mensaje de error.

Estos comandos estan deshabilitados en las siguientes ubicaciones.

Ubicacion/Aplicacion

Ruta de acceso

Notas

. > Calculos > Algebra > Resolver
Sistema de Ecuaciones Lineales

. > Opciones de Cuadro Matematico

. > Calculos > Matriz y Vector >
Simultaneo

Calculadora y Bloc de
Notas

. > Algebra > Resolver Sistema de
Ecuaciones Lineales

. > Matriz y Vector > Simultaneo
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Ubicacion/Aplicacion Ruta de acceso

Catal - Y3
atalogo (i) o TE3 : Deshabilitar linSolve(y Simult(

2: [z <
o " Dentro de Algebra > Resolver

Sistema de Ecuaciones, deshabilitar:
1. Encontrar Sistema de Ecuaciones

2. Resolver Sistema de Ecuaciones
Lineales

«  ? 1% Deshabilitar Matriz > Simultaneo

Como deshabilitar el diccionario chino-inglés

Una vez que ingresa al modo Presionar-para-Examen, el diccionario
chino-inglés se deshabilita automaticamente si esta instalado en los
dispositivos portatiles TI-Nspire™ CX-C. Usted no puede seleccionar la
habilitacion de esta funcidon mientras esté en el modo Presionar-para-
Examen.

Modo Presionar-para-Examen para la calculadora
TI-84 Plus

Para ingresar al modo Presionar-para-Examen en el modo TI-84, el
teclado numérico de TI-84 Plus debe estar colocado y el modo TI-84 Plus
debe estar habilitado.

Nota: El uso de Presionar-para-Examen en el modo TI-84 Plus no afecta
los archivos de TI-Nspire™. La informacion de esta seccion solo se aplica a
TI-Nspire™ cuando se utiliza un teclado numérico de TI-84.

Como Habilitar el Modo Presionar-para-Examen para el
Modo TI1-84 Plus

1. Apague el dispositivo portatil.

2. Mantenga presionadas [, ]y hasta que se abra la pantalla
Restablecer Opciones.

REZET OFTION:
DIZAELE AFFZs FROGRANE

ANGLE: RADIAN [T
STAT DIAGROSTICE: [I OFF
DIZAELE 1e3ER=E: {3 no
DIZRELE Zo: [{3 no

[EC)  [(OR )
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De manera predeterminada, el modo de dngulo esta configurado en
GRADO, los Diagnésticos de Estadisticas estan activados (ON) y las
funciones logBASE y sumatoria (}) estan deshabilitadas.

Para cambiar las configuraciones predeterminadas, mueva el cursor
sobre la configuracion deseada y presione (ENTER].

Presione (debajo de OK en la pantalla) para seleccionar OK.

Las opciones que usted haya seleccionado se despliegan en la
pantalla Restablecimiento Completo.

DISHELE AFFS: PROGRANZ
ANGLE: DEGREE
STAT DIAGROSTICE: ON

DIZAELE 103BERZE: YE=
DISAELE Z: YE=
EAMis REZET

Fressant Hey...

Presione cualquier tecla para continuar.

Pare verificar que las Aplicaciones, los Programas y las funciones
estan deshabilitadas:

Presione [APPS i

AFFZ HAVE EEEN
DIZAELED
LINK-RECEIVE L1 (OF ADY
FILE} TO RE:XTORE

Fress ant K.,

Presione [PRGM 0
FROGRANZ HAYE EEER
DIZAELED
LINK-RECEIYE L1 (DR ANY
FILE} TO REZTORE
Fressany K.,
Presione [ALPHA
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Presione [MATH] 1 HUM CF¥ FRE

Otras variables almacenadas en RAM y en la memoria archivada
(incluyendo VarsAp) se borran.

Como Verificar que las Funciones estén Deshabilitadas en

el Modo TI-84 Plus

Cuando los estudiantes intentan tener acceso a las funciones
deshabilitadas, se despliegan las siguiente pantallas informativas:

To3ERSZEC HAE EEEN surmation Z0 HAS EEEN
DIZAELED DISAELED
LINK-RECEIYE L1 COK AnY LINK-RECEIYE L1 COK AnY
FILEY TO RE:TORE FILEY TO RE:TORE

Fressant Hey... Fressant Hey...

Nota: Si un dispositivo portatil ya esta en el modo de examen, las
aplicaciones y los programas se deshabilitan. Si intenta iniciar el modo
Presionar-para-Examen en un dispositivo portatil TI-Nspire™ utilizando el
teclado numérico de TI-84 mientras se encuentra en el modo Presionar-
para-Examen, se despliega la pantalla Restablecimiento Completo. Las
configuraciones actuales se muestran y la RAM se restablece. El
dispositivo portatil estara listo para que otro estudiante lo use en un
estado de prueba limpio segun sea necesario.

DISHELE AFFS: PROGRANZ
ANGLE: DEGREE
STAT DIAGROSTICE: ON

DIZAELE 103BERZE: YE=
DISAELE Z: YE=
EAMis REZET

Fressant Hey...

Como Salir del Modo Presionar-para-Examen en el Modo
TI-84 Plus
Cuando vuelve a habilitar los dispositivos portatiles TI-Nspire™ utilizando

un teclado numérico de TI-84 y los dispositivos portatiles TI-84 Plus, se
restauran las Aplicaciones y los Programas.
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Para restaurar un dispositivo portatil TI-Nspire™ en el modo TI-84 Plus a
su funcionalidad completa:

e Enlace su dispositivo portatil a otro dispositivo portatil TI-Nspire™ en
el modo TI-84 Plus o a un dispositivo portatil TI-84 Plus.

e Transfiera cualquier archivo hacia o desde el dispositivo portatil que
se encuentre en modo de prueba.

¢ De manera alternativa, puede usar TI Connect™ para descargar un
archivo desde la computadora a su dispositivo portatil.

Para transferir un archivo desde otro dispositivo portatil TI-84 Plus:

1. Enla unidad receptora, presione [LINK] y después resalte RECIBIR.
No presione todavia.

2. Enla calculadora transmisora, presione [LINK].

3. Seleccione un archivo para enviar al seleccionar una categoriay
después seleccione un archivo para enviar.

?ailf RECEIVE H!!!ﬂl TRAHSMIT
sHIL1+. = [y LIST
2EA11-.. = |L: LIST
i Pran.. P Lz LIST
E‘HLZ!.E-‘L... Ly LIST
iList=s to TISZ.. Le LIST
&2 50E... Ls LIST
rlLPic..

4. Resalte TRANSMITIR para enviar el archivo, pero no presione [ENTER
todavia.

SELECT IlﬁEIIHiIIl
lHTran=m1

5. Presione [ENTER] en la calculadora receptora.
6. Presione [ENTER] en la calculadora transmisora.

Nota: Puede ser necesario renombrar o sobreescribir su variable para
que la transferencia del archivo tenga éxito.
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Nota: La aplicaciéon Tl TestGuard™ para los dispositivos portatiles TI-83
Plus y TI-84 Plus no estéa disefiada para ejecutar y transferir
configuraciones de prueba cuando se encuentra cargada en un
dispositivo portatil TI-Nspire™ en el modo TI-84, incluida la funcién
Rehabilitar. Asimismo, las luces LED parpadeantes que indican que usted
esta en el modo Presionar-para-Examen no parpadean cuando se
encuentra en el modo TI-84.
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Apéndice: Informacion sobre servicio y

garantia

Soporte y Servicio de Texas Instruments

Para los EE.UU. y Canada:

Para obtener informacion general

Pagina Principal:

Base de
conocimientos y
preguntas por
correo electrénico:

Teléfono:

Informacion
internacional:

education.ti.com

education.ti.com/support

(800) TI-CARES / (800) 842-2737
Para los EE.UU., Canada, México, Puerto Rico y
las Islas Virgenes unicamente

education.ti.com/international

Para obtener soporte técnico

Base de
Conocimientos y

soporte por correo

-electrénico:

Teléfono
(no gratuito):

education.ti.com/support

(972) 917-8324

Para servicio (hardware) de producto

Clientes en los EE.UU., Canada, México, Puerto Rico y las Islas
Virgenes: Siempre contacte a Soporte Técnico de Texas Instruments
antes de devolver el producto para servicio.
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http://education.ti.com
http://education.ti.com/support
http://education.ti.com/support
http://education.ti.com/international
http://education.ti.com/support

Para todos los demas paises:
Para obtener informacién general

Para obtener mas informacién sobre los productos y servicios de TI,
contacte a Tl por correo electrénico o visite la direccién en Internet de TI.

Preguntas por ti-cares@ti.com
correo electrénico:

Pagina Principal: education.ti.com

Informacion sobre servicio y garantia

Para obtener informacién sobre la duracién y los términos de la garantia,
o bien sobre el servicio para el producto, consulte el certificado de
garantia incluido con este producto o contacte a su vendedor o
distribuidor local de Texas Instruments.
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